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(e e General Bathymetric Chart of the Oceans

B tim e ek sl e The General Bathymetric Chart of the Oceans (GEBCO) consists of an international group of experts who

work on the development of a range of bathymetric data sets and data products, including gridded
bathymetric data sets, the GEBCO Digital Atlas, the GEBCO world map and the GEBCO Gazetteer of
Regional mapping projects Undersea Feature Names. [more]
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MEW! We are involved in training a new generation of scientists in ocean bathymetry through the Nippon

Foundation/GEBCO Training Project. [more]
Welcome to the newly-
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Gridded bathymetry data top page

Gridded bathymetry data

GEBCO provides global bathymetry data sets for the world's
oceans.

We make the following gridded bathymetry data sets
available:

* The GEBCO_038 Grid — 3 global 30 arc-second grid
largely generated by combining quality-controlled
ship depth soundings with interpolation between
sounding points guided by satellite- derived gravity
data. However, in areas where they improve on the

existing grid, data sets generated by other

methods have been included. Land data are largely

based on the Shuttle Radar Topography Mission (SRTM20) gridded digital elevation model. A
‘source identifier’, SID, grid is also available to download to accompany the GEBCO_08 Grid.
This shows which grid cells have been constrained by bathymetry data during the gridding
process.

* The GEBCO One Minute Grid — a global one arc-minute grid

Click the link to download page

contours contained within the GEBCO Digital Atlas.

On behalf of GEBCO, the GEBCO_08 and GEBCO One Minute Grid arl available to download jom the
British Oceanographic Data Centre (BODC). Using this web application, you can select to download the

complete global grid files or data for a user-defined area using an interactive map or by entering the

Released: 2003, updated: 2008 — largely based on the most re EJ ST OT DTS

geographic co-ordinates of your area of interest in a dialogue box.
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General Bathymetric Chart of the Oceans (GEBCO)

Gridded bathymetric data sets

GEBCQ's aim is to provide the most authoritative, publicly-available bathymetry for the world's
oceans. It operates under the joint auspices of the Intergovernmental Oceanographic Commission
(10C) and the International Hydrographic Organization (IHO).

Two GEBCO gridded bathymetric data sets, maintained and distributed by BODC, are available to
download as netCDF files. You may opt to download data for a user-defined area or the complete
global file(s).

* The GEBCO One Minute Grid — a global one arc-minute grid

Released: 2003, updated: 2008 — largely based on the most recent set of bathymetric

contours contained within the GEBCO Digital Atlas. Bathymetry data from the GEBCO_08 Grid

=

The GEBCO_08 Grid — a global 20 arc-second grid

Released: September 2010 — generated by combining quality-controlled ship depth soundings with interpolation between sounding
points guided by satellite derived gravity data. A "source identifier’, SID, grid is also available to download to accompany the GEBCO_08
Grid. This shows which grid cells have been constrained by bathymetry data during the gridding process.

The GEBCO_08 Grid is currently a development product which will undergo periodic update. Although every effort has been made to
reduce the number of errors in the data set, we expect that some grid artifacts will be found. A list of reported bugs may be found on the
errata pages.

To download the data you are required to be a registered BODC web user. If you have already registered, please log in, alternatively please
register th become a new user.

Additional info

For downloading GEBCO data, you need to create an account,
Data set documentation a . .
S register, and log in to the account home page




Registration
—_— s —

My account

User registration

Why register?
By providing us with a few simple details about yourself we can
* Provide you with access to our inventories and data download areas

¢ Keep you informed of changes to this site and the data accessible through it

* Get 3 better idea of who our customers are and what they want

If vou consider yourself an academic user, please reqgis s to quickly

Fill in the forms and create your account

validate vour academic status.

Stk ~ /

I |l
| Email address:
I I Your login details
: |
I Password: I You will use this information to login to areas of the BODC web site. The
I I password may be between 8 and 20 characters in length. Capitalisation also
: Confirm password: I matters for your password!
| |
I . I .
| Title: & I Your contact details
| _ I The 'Personal Details' provided will not be given to any third parties and will
| el name; I only be used to provide you with data and/or information and to generate the
| I online licences for when you reguest data.
| Last name: |
I | This information will also enable us to characterise the user profile of clients
I Organisation: | using BODC web services over the internet. This characterisation of the client
I | base will allow us to direct future web-based developments and services to
I Address: | you, our users. It will also provide '‘performance indicators’ to support future 5
l | funding of our web development.




Link to bathymetry data

* The GEBCO One Minute Grid — a global one arc-minute grid

Released: 2003, updated: 2008 — largely based on the most recent set of bathymetric
contours contained within the GEBCO Digital Atlas.

Bathymetry data from the GEBCO_08 Grid

©
* The GEBCO_08 Grid — a global 30 arc-second arid

Released: September 2010 — generated by combining quality-controlled ship depth soundings with interpolation between sounding
points guided by satellite derived gravity data. A 'source identifier’, SID, arid is also available to download to accompany the GEBCO_08
Grid. This shows which grid cells have been constrained by bathymetry data during the gridding process.

The GEBCO_08 Gnd is currently a development product which will undergo periodic update Althovah every sffort has heen made to

reduce the number of errors in the data set, we expect that some agrid artifacts will b . H : H H
st After registering and logging in, link
button to download page appears

Users must familiarise themselves with the terms of use before accessing the GEBCO bathymetry #ata.

I have read and agree to the terms of use

Access the GEBCO gridded bathymetry data

Additional information

Data set documentation along with information on export formats, grid version numbering and bug alerts for each of GEBCO's gridded data sets
15 also available

e GEBCO 08 grid — 20 arc-second resolution

s GEBCO one minute grid — one arc-minute resolution

Free software 15 available for viewing and accessing data from the grids in ASCII as well as netCDF. Find out more about the GEBCO Grid display
software




GEBCO gridded bathymetry data sets
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General Bathymetric Chart of the Oceans (GEBCO)

Gridded bathymetric data sets

Data are available for download from GEBCO's grnidded bathymetric data sets in netCOF. You may opt to select and download data for a

user-defined area using the map or form below or use the default global area to download the complete grid files.

To accompany the GEBCO_08 grid, a "source identifier’ or SID grid is also available; this shows which grid cells are based on bathymetric

soundings or depth values from a agrid and which cells contain predicted depth values.

Please note that the bathymetric grids do not contain detailed information in shallow water areas.

Interactive map

Use the interactive map below to define the geographic area of the gridded data sets that you want to download. Alternatively, type the

coordinates of the required area in the form below the map.

The default display is the GEBCO One Minute Grid. To view the GEBCO_08 Grid (30 arc-second resolution) use the Toaggle gnd display’ tab above

the map display area.

The GEBCO_08 Grid display includes the option to view the Source Identifier (SID) grid by toggling the 'Togale SID grid display'. It shows those
gnd cells for which the data in the GEBCO_08 Gnd are based on bathymetric sounding or grid values. It is best viewed at a zoomed in level to

appreciate the detail in the data set.

Latitude 80°42°0"N

Longitude 155°55'12"W

In the download page, you can
select your region of interest
in the interactive map like
shown in this figure, however,
several steps are needed for
accessing GEBCO data.




Downloading world ocean data

Northernmost .= ]

latitude (7) = = [yt

R — Easternmost

longitude (7

Westernmost
longitude (%)

Firstly, you must download the

Leave values and characters unchanged whole data, namely,
w e | e GEBCO_08 grid (30 arc-second

interval).

Southernmost G e ——
latitude @ S0 o 5 eset to Wor

Download data

Grid selection
Use the tick boxes to select the dataset you wish to download for the geographic region defined above

Depending on the grid resolution and the size of your area selection, data delivery may take severa or this reason t

different grid files need to be downloaded separatsly.

GEBCO_08 Grid (20 arc-second interval) ()

GEBCO_08 SID Grid (20 arc-second interval) ()
GEBCO One Minute Grid (1 arc-minute interval) @ D

Grid format selection

The data file will be made available as a netCODF formatted data file consisting of a one-dimensiongf (1D) array of 2-byte signd

integer values.
Eree software is available to download to view and access the data in ASCII or netCDF formats. Fugther information can be foun

the data set documentation.

Download

You must download the documentation first which includes the license and grid documentatio

\

gebco_08.zip FE§< E

ROT7ANERTDELTVET:
I gebco_08.zip

77 -TIADFER: Compressed (zipped) Foid

7 -TIADISFT: hitp://www.bodc.ac.uk
COIFILEEDLESICIET BT REEN

© FOYSLTEL(Q): |Lhaplus Version 1.59 (L&) -]

@ FPTILEREFTB(S)

[] S®BCOBROT 7 ILIEEECNET5(A)

| oK H:Fv:zizml

Drownload Documentation i[ Download Data ] I

Datza delivery may take several minutes depending on the grid reseclution and area selection, please be patient.




Downloading free software

Use the tick boxes to select the dataset you wish to download for the geographic region defined above.

Depending on the grid resolution and the size of your area selection, data delivery may take several minutas Ear thic rascan tha diffarant arid

files need to be downloaded separately. Secondly for VISU3|IzatI0n Of
’

R oMl | GEBCO data, a software
1 provided in the same page is
g needed. Download link is just

above the “Download Data”
button.

Grid format selection

The data file will bg m as a netCDF formatted data file consisting of a one-dimensional (1bramay orz=oy = SONMeT TICEgET VaIOes:
Free software islavailable to download to view and access the data in ASCII or netCDF formats. Further information can be found in the data set

Download

You must download the documentation first which includes the license and arid documentation.

Download Documentation ] [ Download Data

Data delivery may take several minutes depending on the grid resolution and area selection, please be patient.

Additional information ﬁ

Data set documentation along with information on export formats, and version numbering and bug alerts for each of GEBCC's grnidded
data sets is also available

¢ GEBCO 08 grid — 30 arc-second resolution

« GEBCO one minute grid — one arc-minute resolution



BODC software products
GEBCO Grid display

The: GEBLD gnid display software allows you to view and access dala from GEBCD's gridded Bathymetnc
dats z=l=

# fhe GEBCOD One Minute Grd — s global one arc-minuts gnid

# the GEBCD_ 05 Grid — a global 30 arc-==cond grd
The: zoftwars i availabls to download under licence and can be vsad with sither or both gridded dats sat=,

Flzaz= nol= thal the software is designed for use with the complete, global dats files, IT will not
work with subsets of the full global dats s=ts.

It providas the means fior displaying the dals and socessing the dats in netCDF and also in simpls ASCTT Wizwirg dala from the GEECO_DE Grid &

Tormiats, incheding one suitable for conversion To & mster file which can be u=sed with ESRI ArclGIS products.

The software has been developed by BODC to nen on a PC renning Microsolt Windows 95 or later. It is controlled By a8 sedex of dop-down menus and

Tooibar bultons. The current version is 2,13 and was rel=a==d in &pril 2010,

Find oul more about the GEBCO Grd display scftwars and updates included in this release, I':"_'] [27 KE)

Features of the GEBCO Grid display software

Di=play GEECC's griddad Bathymetric dats zet= on your PC screen, oolowr coded for depth/sleyvation,

Export data in simple ASCTI formeats incheding a format that can e converted to & rast=r M=, which can e w=ed with ESRIL ArcGIS products.

Export datls in retCDF.

Choioe of Thre map projections for display — Bquidistant Cylindrical, Mercstor, Miller Cylindrical, Lsmisert Cyfindrical Equal-&mea and Polar

Stereographic,

Select your geographic area of inlerest =ither by charl number, by latitude and longitude limils, or by an on-screen. zoom: box.

Cheriay a geographic gnd Tor relemencs,

page.

i e e Link to GEBCO Grid display software

il i N is at the bottom of the download

Reported bug on 31 July 2012

& bug has besn reported in the GEBCD grid display softwars that aff=cts the export of the GEBOD OB Grid and GEECO 08 SID o In some limited cames
wihen the selscted geographic region Tor export = defined as & fraction of & whole degres, hen he axported dals valus@anch grd point hax Been shilt=d

{in longitude=) by one grid c=ll, i.=. 30 ac-s=conds, from its. comect vale=.

We apclogise for amy imcomreniznoe caused and are working to fioc this Bug. We will maks a reviss ion of the scfiware available as soon as possible.
In the meantime, we recommend that vs=rs of the GEBCD gnid dizplay soffwane s=i=ct Braphic regions Tor =xcport al whole degree inlervals miler than
as fractions of a degree.

Software download

T download this =oftware you are reguirsd o Rave a8 L weh w=er acoount. IT you have already registersd and have an acooent, please Tollow the link

bBelow to download the =oftware. Atemathvelr, r o become a mew e,

Downioad Tlg GEEBCO Grid display scftwarll — the download consists of 8 compres=sd zip fil= contsining the software, the user guite snd help Niles {3000
KE).

10




Grid Viewer download

[
oleshd  » RN-5842_ 1377027279934 = RN-5842_13770272799340018% P
EE - S JSUICEN =HE - s=AD FLWIA IS — = O @

-~

v BRICAD = A E5HE EE 2 K P4
& Google 53 |&#| GEBCO.Dat 2003/03/13 10:16 DAT 7). 5 KB
g FonOo—Fk Xl geboo_08.pdf 2011/05/05 10:39  Adobe Acrobat ... 263 KB
el i | GEXPORT.x¢t 2009/04/060 9:49 TXT 271 ). 4 KB
 ERERL S '@grid_view_&:-ﬁtware.pdf 2010/04/15 9:07 Adobe Acrobat ... 70 KB
o - '@Igrid_view_aoftware_dl.pdf 2011,/05/05 10:12 Adobe Acrobat ... 70 KB
E T4 gridone.pdf 2009/02/25 8:57  Adobe Acrobat ... 791 KB
- I T1I5Y (E GridViewerexe 2009/07/09 17:14 FFUb—i3 2,421 KB
B FEFaxzb T help.pdf 2010/04/15 8:55  Adobe Acrobat ... 584 KB
FR=Fay | IBCM.Dat 2003/01/24 11:46 DAT J7-IL 1 KB
- '@ licence_for the use of ... 2007/01/18 16:58 Adobe Acrobat ... 88 KB
J? =9 _Twh '@ Manual.pdf 2011/05/05 10:45 Adobe Acrobat ... 2,009 KB
| |#] netcdfd 1998/09/23 16:05 FTU&—=s... 251 KB
*% s 5 j" I || gebco_08.nc 2010/10/25 14:43 NC 7l 1,822,501 KB I
R— 50—

L ) i Rt
’ 13 EnIEE

Unzip the downloaded software file and put the
gebco_08.nc file in the same directory after unzipping
gebco 08.zip (1.1GB file you’ve just downloaded) file.

11



Execute the viewer

L W™ |, Rn-5842 1377927279934 =

HE - B HE~Y BERAO HFLLWIALY- =~ 0 @
- e f Er O =] H X
g 3—3\%“:}\@ p— %HU f%_ﬂ_ﬂ' I==5 e R
& Google F5-15 |#| GEBCO.Dat 2003/03/13 10:16  DAT J7-1il 5 KB
g FooO-—F X geboo_08.pdf 2011/05/05 10:39  Adobe Acrobat ... 263 KB . .
WAy T || GEXPORT.txt 2009/04/06 9:49  TXT I7 L 4KB Execute the GridViewer.exe
= ErEs | ieiSh '@grid_view_soﬁware.pdf 2010/04/15 9:07 Adobe Acrobat ... 70 KB
s - Eﬁ]grid_view_software_dl.pdf 2011/05/05 10:12  Adobe Acrobat ... 70 K
= Aridon s o df 2nnafn2/2c 9o W T = i |
- Z1I5Y (E GridViewerexe 2000/07/09 17:14 FITUL—3> 2,421 KB|
B Rfaxh ] = T o t o8
'ﬂ 2 b 271D GEBCO Grid Demonstrator e HEKE
E EoFe el £+t British Oceanographic Data Centre f1L 1 KB
EL‘] licence for_th| Z=-JL JI—= > 2.1.3.0 robat ... 88 KB
J =1-Sws T Manual.pdf | {ERLEE: 2013/08/31 14:40 robat ... 2,009 KB
] netcdf.d TAA:2.36 MB =N 251 KB
|| gebco_08.nc 2010/10/25 14:43 NC T 7-TiL 1,822,501 KB
o =LA~
ol e —g— T
Gridviewer.exe S3HE: 2009/07/00 17:14 {EREEE: 2013/08/31 14:40
CE FIUE—23k HAZ:2.36MB

GEBCO Gnd viewing and data access software.

This software is provided to enable vou to view ahd access GEBCO's
gridded bathymetry data. Software features not associated with the zrd

file are disabled. They require extra data files which are available on the
GEBCO Digital Atlas CDEOM.

Continue |

Click “Continue” 12




Region settings

GEBCO Gri

Data Source  frea | Palette | Contours | Chart Wiew | Supplementary Data l Graticule I SCAR e |

— Projection
f+ Equidistant Cylindrical
i Mercatar

Chart Mame I ;I

— Select fram the Map

{~ Lambert Cylindrical Equal-frea
Select Area | & Miller

% lsze Zoom

¢ Lze Chart Qutlines  Palar  Central Meridian ]U EI

Input the region of interest

— Exact Area

Morthern most latitude
fi M

Weztern mozt longitude Eastern most loneitude
||95 E [7:1 I ||!;u3 | JI

Southern most latitude

m

Clear | Digplay Format :

Decimal Deerees

13



Aceh BODC data

File Select Display Map

Info

Window Help

o[- o
[F] ]

JOPE]

Height in Metres

=4000
4000
3000
2000
1000

S00
0

Depth in Metres

0

Graticule

14



Data export

"G GEBCO Grid Dem

Select Display Map Info Window Help

123
cos B |- i
Save As... A | mmml =t 0 |
Export Data | Vector Data =

Copy to Clipboard Gridded Data

Exit

Export this data for QGIS
processing
Click “Gridded Data”

15



Export options

Depth in Metres

i D

GEBCO Grid Demonstrator : Export Data Dialeg | <5 (E | Date @

{FAT S BIBFD: l | esboowork j o £ Ev
— Format D= :g‘ﬁ-ﬁ = EZi=ling =3
" ASCI - Longitude Latitude Cepth i i ST g
iR T LR . Images 08/ : dFAIL T,
| ~ B5CIH - Depth only
& ASCIH - for conversion ta ESRI raster farmat I _.-
TAAT
" netGOF - GMT (2 byte Inteeers) =
="
Output Filenatme : 5431
C:hUzersh “Desktophgebcoworkacehfpsc . |
LY
|: B ey e
rowsE I 5
= N
(N
Fahrl-5
J Ok l x Cancel i 4 i | r
e b == lacehascl _‘_'j | {FRTF(S) I
] TP NOIEEED:  [ASTacc) -] et |

Select “ESRI raster format”

Input name as “aceh.asc”

16



tpo file preparation for ELIMO solver (optional)

[l Untitled - iRIG [Elimo]

File Import Geoeraphic Data Grid Measured Walues Calculation Gondition  Simulation

B acehazc - TeraPad O] = IEE @O [t [ %D Zx|mw & RO [erre 2 T »

FrAIMEY RRE(E) 23S FTON R0 w— (T AJLTHHD

DEE & $ B2E < o~ o
2 sy sy e e e e e

TR .
I ted tpo fil "
mporte PO TIle t'u

in ELIMO|solver

/\<QE1QT1 209717 [ 601451117477

&

§2 acehtpo - TeraPad

REE BES SR oW Y—KD ALE
EE S §BR| o o fhoa e
.

||1|:||||| ||2|:||||||||||3|:||||||||||4|:||||

17T 1T

The ELIMO solver needs longitude and latitude data in tpo file. Open
aceh.asc in your text editor (or Excel), delete the header information in
the file (14 lines from the top), count the number of data points, add it
in the first line and save as tpo file with .tpo extension like “aceh.tpo”




Ope Nra Ster |ayer If you are going to use other solvers,

following procedures are needed.
5 [#] Quantum G |..$r

| |

File Edit Wiew Layer Settings Plugins Database WVector Raster Help

A EB &S ﬁi’é’@aﬂf’ﬁ‘@ s@CRoPad o -
) Add Raster Layer =

savdasTdocy il MAARAIALR £ 0O

PR EmY R & A
Layars
r,;'ﬂ Open a GDAL Supportad Rester Dats Source . ¢ . W ¥ W ﬂ1
'®q| ki » g@Ewcﬁ ¥ - |&,|| geiEs'.vsr}'c@Tﬁﬁ o|
28 > HUWTALT— =~ 0 @
& Subwversion * Za . EFHE
[ FFaxh | &) aceh.asc 2013/08/31 1!
] " ) B EsFr
Click “Add Raster Layer -
et A
. g —TwH
and select “aceh.asc” file L e
M aLE1—s— S

m
H
i
C

& O-hLF1Z5 (C)
s O—HIL T4 A% (D:)
- =TI T 28 (F)

€ ®y -4

N - 4 1 | 3

‘* I7-AILE(M): aceh.asc - ’[GDAL]AIIﬁIes(*] (%) ,]

| <0 |+ [ o3l ]
OR2BwWE».A®K -
Ready _ [®])| coordinate: | | scale [[1:15 [&][% Render |[EPsc:2455 |[@)] J
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Define CRS

-/ — /W osess-----seesNE—"—=——S Ny

-
J# Coordinate Reference System Selector
=

L9 o)

Define this layer's coordinate reference system:

that of the project, but wou may override this by selecting a different projection below.

Thiz laver appears to have no projection specification. By default, thiz laver will now have its projection set to

EPSG:4326

- Wake Island 1952 EPSG:4733
- Wallis - Uvea 1978 (MOP78) IGMF:WALLYS---

Coordinate Reference System Authority ID I Fﬂ
- WG5S 66 EPSG:4760 3603
- WGS 72 EPSG:4322 3450
- WGS 72BE EPSG:4324 3451 Define the CRS

(Coordinate Reference
System) as “WGS 84”

+proj=lonelat +ellpe="WGE58d +datum="WiGE584 +no_defs +towes84=0,0,0
Search
Mame -

futhority | &l »  Search for

wes 84

Recently uzed coordinate references systems

Hide deprecated CRS=

(EPSG:4326 or ID:3452)

Coordinate Reference System Authority ID |ID |
WGES 84 [ UTM zone 47N EPS5:32647 3131
DGM9S [/ Indonesia TM-3 zone 46.2 EPSG:23830 1991
WES 84 EPSi5:4326 3452
WGES 84 [ UTM zone 46M EPSG: 32646 3130
| QO Cancel Help
e ————— — — ———"—H 19




Raster layer added

File Edit WView Layer Settings Pluging Database Vector Raster Help

TBRrEdddo RRPPPURPIS 7adXo D on
NN AWAAADND « S0 ol @QAARKRRAQAQ PO |
P - D SRR T

Layers 0

..... f@. Zoom to layer extent

Zoom to best scale (100%)

Stretch using current extent

Show in overview

# Remove
Set ayer CRS Grey square region will
Set project CRS from layer I
— oppear
— In Layers window right
gwm” click the aceh layer
['d] Collapse all .
Select “Properties”

+

@ 0GIS 2013
©.d2sﬂlﬂﬁ‘9m.ﬁ\m\@ﬁﬁ
[®5]][ coordinate: | 95.165,5.999 [ scate |12 |[&][ Render |[EPsc 2455 |[@)] A
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Set color map

File Edit View Layer
T BEEd S RRPERPURP IS 70 Ko Do~ s
T ELL VER « SO L [AARKRRAQLE 20O
P T Dm- @ R -

: ..

¢ [ aceh
-

Settings Plugins Database Vector Raster Help

Wi Style F"_ Transparency [ Colormap Q’k General \ﬂ) Metadata :-'”" m
Render az

® Single band eray () Three band color Ihvert color map

Sinele band properties

Gray band | Band 1 -
ICc-Ic-r map | Pzeudocalor - I
L .
O Custam min / max values M#\—ZHNB?UQ] Max [2.147482+09

I ® Uze standard deviation 0o ﬂ r e
] B ..

Mote: Minimum Maximum values are estimates, user defined, or calcllated fram the current extent - © QG5 2013
Load min / max values from band Contrast enhanfement o o".l m g ’I'EI
Estimate (faster) Current [No Str*ch v] | :
Actual (slower) 947305 673 [ scate [[1 |[©][% Render |[Ersc2455 [ @]
Default Mo Stret
Current extent elan 0 SIete
Resztore Default Style Save Az Default Load Stvle .. Save Stvle . I

el " | Set Color map of the Elevation




Convert raster to vector

File Edit View Layer Settings Plugins Database Vector |Raster| Help
o - i r Raster calculator ... . n - i, . iy
1T=mEdd & RKP ﬁﬁp f 2 @0 PPHyH i »
Projections [ .
A ,r = Rasterize (Vector to raster ‘."_ _';. Q |
CFENLT AT ~ ( L AR &
Extraction 157 p e (Raste -
|F9 i w e j —_— £l Ev . : olygo 3 ¥, 0
: - - , @5[:] ﬁ : Analysis ’ Translate (Convert format)
Layers = "
E i : | 0 Miscellaneous %, RGB to PCT
GdalTools settingd |-
= PCT to RGB
i@ About GdalTgfls
2 Polygonize (Raster to vector
Input file {raster) aceh Select... -
i
Qutput file for polyeons {shapefile* work faceh_vec shp I Select...
Fiold name on / | In the menu bar, click Raster > Conversion >

“Polygonize (Raster to vector)”
el polygonizsbat G Input file name for polygons

¥lzers¥montedio_user¥ Desktop¥eeboowgvk ¥aceh asc —f “ESRI - CI |Ck llo KII

Load into canvas when finizhed

Shapefile”
i/ Jzers montedio_uzer/ Desk top/eebgtwark Saceh_vec zh

- P - F | e o T Y ® QIS 2013
82

aceh_vec
I 0] 4 I Cilose Help Ils,ggg || Scale || 1:8 ||!t Render || EPSG:2455 | 22




Add vector layer

e T

1=mEd & o HRPIS 79> XNc¢
o oy Sy O G | «SOE il [} QXK
P R D E O RE O

Layers 0
B % B aceh ;

-
A add Vectuhaqq

Source type

k e File Directorsy Databaze Protocol

Encoding | SHIFT-JIS

Source

Dataset i:¥Llsers¥mu:unteu:liu:u_user¥Desktup¥gebcnwurl¢¥aceh_&-‘ecShp I’ Browse ]

pEn | Cancel Help
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Specify CRS

-/ — /W osess-----seesNE—"—=——S Ny

Search

Authority | &l »  Search for ID

Fecently uzed coordinate references systems

+proj=lonelat +ellpe="WGE584 +datum=WiE584 +no_defs +towes=84=0,0,0

Hide deprecated CR5=

Coordinate Reference System

Authority ID

|ID

WGES 84 [ UTM zone 47N
Indonesia TM-3 zone 46.2

WGS 84 [/ UTM zone 460

EPSG:32647
EPSG:23830
EPSG:4326

EP5G:32646

3131
1991
3452

] %

Cancel

P — -— -— — —— '- w w
2 Coordinate Reference System Selector M

Specify GRS for laver aceh wvec

Coordinate Reference System Authority ID I B
- WG5S 66 EPSG:4760 3603
- WGE 72 EPSG:4322 3450 |:|
- WG5S 72BE EPS5G:4324 3451
- WG5S 84 EPSG:4326 3452
- WGE72 IGNF:WGS72G 10050
- Wake Island 1852 EPSG:4733 3576 %
- Wallis - Uwvea 1978 (MOP78) IGNF:WALLY8--- 10049

Again, define the CRS
(Coordinate Reference
System) as “WGS 84"
(EPSG:4326 or ID:3452)

pLi!




Save vector layer as UTM

Layers

x| aceh_vec |,

Layer Settings Plugins Database Vector Raster Help
T EEd s RRPPRPURP IS 74
FEALLYEREITI"EE R 22
P e D ® R R T-

@ | g
|

(@ Zoom to layer extent
Show in overview

2 Remove
Set layer CRS
Set project CRS from layer

[=] Open attribute table

# Toggle editing

New vector layer is added
Right click the layer name
and click “Save as...”

Add group
[ Expand all

Input the name for output
Select "Selected CRS”
Browse CRS and here, you must

choose “WGS 84 / UTM zone 46N”

' Save vector layer as...

Farmat ESRI Shapefile

Selected GRS |

GRS

Save as 3erfDesktDpr’gebcnwur|fau:eh_vec_utmshp I

/v{’ing SHIFT-JI5 /

I'I.I'I.I'GS 84 S UTM zone 46M

0GR creation options x

A==
Browsze
Browsze

Recently uzed coordinate references systems

Coordinate Reference System Authority ID ID
WGS 84 / UTM zone 47N EPSG:32647 3131
DGNSS [ Indonesia TM-3 zone 46.2 EPSG:23830 1991

[ collapse all

+

WGS 84
WGS 84 [ UTM zone 46N

EPSG:4326
EPSG:32646

Lawer

Skip attribute n:reatin:nrw

Cancel

Help |




Add vector layer

& Add vector layer

Source type

e File Directory Databaze

Encoding | SHIFT-JIS

Source

Protocal

Add vector layer
in rectangular coordinates system

Dataset ers¥montedio_user¥Deszktop¥eeboowork¥aceh_vec_utmshp

Open

Cancel

B Quantum GIs 1

File Edit View Layer

M EE

9 R ooy

Layers

El- 3¢ G aceh_vec_utm
[ |
El G aceh_vec

= aceh
-

Help

Settings Fluging Database Vector Raster Help

=S R ® -
@x g
L]

+

OREBREPAOK N — PS5

o RRPEPURP IS 2300 D on
N AN AANZONDE «F T

FEEYERTRYEL

Zoom Full

@ QG

|| coordinate: | 818546,566292 |‘ca|e [ 1:895240

||s Render | EPSG:2455 |
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Convert polygon to point data

File Edit Wiew Layer Settings Plugins Database |Vector | Raster Help
o g 4 4 = Analysis Tools » - i ™ [
TEEHdSe BRRE L o0 Py D s >
¥ Research Tools 3
@ £ i “]" +
%y Wy A A (U Do ceoprocessing ok @adrAAaa PO
=3 e ) =l Geometry Tools Check geometry wvalidi
P Rrexy B D & & /7 = heck geometry validity
: . ; . 4 Data Management Tools » Export/Add geometry columns
Leyare ) - geme o Export/ geometry
= £ aceh vec utm 1k Polygon centroids
P ® Delaunay triangulation
El ; @ aceh_vec Voronoi Polygons
E| iceh & Simplify geometries
«% Multipart to singleparts
@2 Singleparts to multipart
@ Polygens to lines
" Lines to polygons
@ Extract nodes
A Polygon centroids L.L
Ihput polveon vectar laver
{aceh_vec_utm [
N
l Output paint shapefile

OCL“BdEP AL u—-TRB8a
| Coordinate: ||

779894 662335 | Scale

intedio_uzer/Desktopfeeboowork faceh_vec_utm_cent shp
[ | )

0% (014 Cloze
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Add geometry columns

-/ — /W osess-----seesNE—"—=——S Ny

& Quantum GIS 1.7.4-Wroclaw

-. ——

File Edit Wiew Layer Settings Plugins Database ’w Raster Help
SEEEEEE T Y

¥ Research Tools
¥ ¥ ﬂ‘ & i ¥ " j‘ Ij @ Geoprocessing Tools

= Analysis Tools

L3R oF

In the menu bar, click Vector >
Geometry Tools > “Export/Add
geometry columns”

@ Check geometry validity

L‘,.l? '_:E% v e lﬁ' E.' ﬁ |T_| v Geometry Tools

& Data Management Tools

Layers 0 _—
x| aceh_vec_utm_cent I gk @ Polygon centroids
e @ Delaunay triangulation
E| . = aceh_vec_utm Voronoi Polygons

% Simplify geometries

E| : . aceh_vec

B i aceh

@® Multipart to singleparts

@2 Singleparts to multipart
@ Polygons to lines

@” Lines to polygons
@ Extract nodes

.
2 Export/Add geomet

Ihput vector laver

' Export/Add geometry columns

Select Input vector layer
Input “Output shapefile name”
Click “OK”

NOTE: It may take several minutes

Click OK and add the new layer

§aceh vec utm cent i
-
A Geometry
Cutput zhapefile
3|:|iu:u_user;'rDesktDpfgehcnwurk'aceh_ve-:_utm_u:u:ulumnshp [ Browse ] 1
- -

[ 0% )

Cloze

8] 4

Created output shapefile:
C:/Users/montedio_user/Desktop,/gebcowork/aceh_wvec_utm_column.shp

Would you like to add the new layer to the TOC?




Geometry column table
T . &

File Edit View Layer Settings Plugins Database Vector Raster .
New vector layer is added

TEEHH S KRREPE P wy Richt click the | 4 elick
AGO0E <« I ight click the layer name and clic
e “Open attribute table”

B R . =) B RS 7).

¢ kT es = ma & & 4 Geometry columns are added d

Layers 0 -
| :

aceh_vec_utm_column

|

DM HCOORD YCOORD

3

o

1

2

3

4 -1239| 726021.761467 | 663168.183303
) —1222;?29228.845238 663176.827018
6

7

8

9

Q_ Zoomtolayerextent Ml |~ L oo . - e
1. @ aceh vec utm Show I overview -1275| 721846.231112| 663149.39105
| -1242 | 722760.041613| 663152.77214
5 ¥ Remove I
: & aceh_vec -1238| 723691.856757 | 663156.166285
Pobe Set layer CRS 1
B .l aceh _ -1236| 724614.676566 | 663159.574654
..... | Set project CRS from laye 1
[

|E Open attribute table

# Toggle editing -1197 | 730151.694433 | 663180.319655

-11?2; 731074.547426 | 663183.826349
-1150; 731007.405238 | 663187.247101
-1131, 732920.267887 663100.881911

Save as...

Save selection as...

Query...

Show feature count 10 -1101 |, 733843.135392|  663194.43 cr:fa
Properties 11 -1075|, 734766.007772 66319?.9’93?[_'!8
Rename 12 -1051), 735688.885048 663201.5?06‘5!5
Add group 13 -1027 |, 736611.767238 6632[}5.151?4.2
[1 Expand all 14 -1000 |, 737534.654361 553208.?568%9
[ cCollapse all 15 -961 | 738457.546437 553212.38501:5
| I 16 -872), 739382.259003 552?55.1002‘5{1
17 -763 | 740303.343525 663219.666534
18 -649 ) 741226.252575| 663223.327885

E] Loak. far if

Show zelected only Search selected only X Caze senzitive fidvanced sear
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Copy attribute table

i ;‘E Attribute Eable - aceh_wvec_utm_column :: 13484 [ 13484 feature(s) selected E@gw
| DN XCOORD YCOORD E
0 -1275| 721846.231112| 663149.30195
1 -1242 | 722769.041613| 663152.77214
2 -1238| 723601.856757| 663156.166385
|3 -1236| 724614.676566| 663159.574684
4 1239 726921.761467| 663168.183303
5 -1222 | 729228.846238| 663176.827018
6 -1197| 730151.694433| 663180.319655 Select all lines and copy them to
7 -1172 | 731074.547426| 663183.826349 ]

E -1150| 731007.405238| 663187.347101 clipboard

9 -1131| 732920.267887| 663190.881911

‘10 1101 733843.135392| 663194.43078

11 -1075| 734766.007772 | 663197.993708,

12 -1051| 735688.885048 | 663201.57p#65

113 -1027 | 736611.767238| 6632061742

14 -1000 | 737534.654361 | 662708.766849

15 -961 | 738457.546437%663212.386016

16 -872| 739382.25903| 662755.100291

17 -765| 74030345525 663219.666534

18 -649| 74#226.252575| 663223.327885 @
| am caA —.m-.-n AN AEASCE | ££mTTT AAT TN
...QH’HEH“HJH | ook for n :

u. Show selected only CDEE?‘?IE‘EEE:&IETE ,to C“pﬁl’dul:.{.:trl-l-{:]h fdvanced zearch 7




Convert to X[m],Y[m],Z[m] data

il

T [EATATSLASETTERTTF T Delete the 1st column and "
-~ = " )
B * _| Open Excel and paste ”a fﬁv change row positions like below
ol = . : == e
#27 4 | the clipboard data <p o0 A 5 c 1
pwIR—F 57 TFF A sl 1 XCOORD YCOORD DN
Y /mﬁ wkt_goom 2 7218462 6631494 1275 v
. = & 22768 66315218 1242
Ayl ™ | c | o | E | 4 | 7236915 6631562  -1238 3
1 |whkt_gecm DR ACOORD YCoOOoRD 5 T24614 7T GBEI1ED6 —1236 %
2 12750 7218462 6631454 5 269218 §4631632 —-12358
] —1242 22769 66315218 T 7202288 6631768 1222
4 1238 7236915 A631562 a TIM51 T 6631803 1187
] —1236 7246147 6631596 5 THO74E GEI1838 -1172
5] —1235. 72659218 6631682 10 0 73155874 6631873 1150
T —1 222 7292288 6631768 11 7320203 663150858 1131
a 1157, 7301517 6631803 12 | 7338431 66315944 110
=] =172 730745 6631838 13 734766 631598 -1075
10 11500 73158574 66318773 14 | 73BGEES 663201 6 —1 051
11 —1131° 73259203 6631905 15 | 7366118 6632052 1027
12 —1101° 7338431 6631544 16 | 7375347 6632038 =1 000
13 1075 T34765 563198 17 | 7384575 6632124 —561
14 1051, 7356885 663201 4 18 7393823 46627551 —-872
15 —1027. 7366118 6632052 19 | 7403033 6632157 =765
16 1000, 7375347 6632038 20 | T4 2263 6632233 —G459
17 =981 7384575 6632124 21 T42148 2 EE3227 -546
18 —872 7393523 6627551 22 F430721 6632307 =440
15 =785 7403033 66321597 a9 TADRGRE 2a0aoa ) —Ea=
20 —640 7412263 6632233 S ;cch SRRV
21 =545 T421452 GE63227 X |
22 |POINT(742 480 7430721 6832307 3
I;'.l':\1 L_ll‘:IThl'léIfIFTEJ'lei1 5@2527 Sr—éét_a......%;.«... P B IR I m ‘ | T } m

IIUE TH: 461800.323¢  F—4OEH: 53940 &3t: 18681110749 |[EE|OJ M 100% (=)
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tpo file export

¥ MseRws .11 - Sl=l= 5 Bt A TEAC = W A

=FEo. El. o . e ERE - (g

,__=|‘=_n|v B 7 U= AL LT = ; _
BORE T N AN g o fngze BEE
. & | @+ &1 Input the number of - A AR g i
Hrwdh—F T : : “ d]" RE
S 2 lines in the 1st line
Al e v
A KE/ C D | F E G | I =
ol 1 134841 (¥ gaE A TRE e . -
2 | 8506005 3689121 -1275 — —= M .
( )=m725ryF « |4 l| 72E FwT
3 | B506091 368914  —1242 Sur~=> — & & = a 4] 7
4 | 8506178 3689158 -1238 =2 e HLLWTALS—
5 | 8506265 3689177 —1236 S —
f | 3402584 8226767 -123% (] Microsoft Excel - @&II3U \ kondosan
7 BECORTOE FRRD 273 —{ 900 ‘E‘ 2 montedio_user || Othershortcut
8  G506795 9680202 1197 Save as “aceh.tpo” and select ~ masEa-s—  Jprofile E
5 | BEOABE5 3689312 -1172 .. % Gy -2 Lsrtm 5611 2
I 10 8506875 3689331 -1150 Text (tab delimited) (*.txt) | 2013_Dr.Shimizu |, srtm2tpo C
11 8507065 3689351  -1131 PR J acehwork L ClEze fa
12 | BEO7I56 368537 -1101 k| BifFR LR ) gebcowork L EEE L
13 | 8507247 568939 -1075 i S —
14 8507338 368041 -1 051 S
15 850743 368543 -1027 J7 A IL&(N):| "aceh.tpo”
16 8507522 3568045 —1 000 . jy,ﬂma]:l?$”(gj,zm”*_m]
{18 6507615 368947 —291 {EFLE: montadi B4 SHDEN B4 ML S ML
18 1701554 553318 -572 s montede_tssr FEEEE e N
19 §507801 368951 ~765
20 8507805 3689531 ~649 | @ 5e—oses Yol - 875(s)
21  B507989 3689551 ~546
22  B50808.3 3689571 -440 - =
M4 v ¥ | Sheet! Sheet? Sheetd o ¥ 4] m [

e @O 100% ) U@ 32




Tpo file import to iRIC preprocessor

|Objec:t Browser

4 I3 Geographic Data
4 I3 Elevation
[} Points1

[3) Obstacle

I Roughness condition
4 [V] 3 Grid [No Data]

[} Grid Creating Condition
I3 Measured Values
[ Background Images

[#] [) Axes

Elevation

2.15%=+I03
. 1 a8=+003

1. =003

Open iRIC software and
import “aceh.tpo” file
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End.



